Optimizing Your Job For Commercial Printing

@

If you're looking for higher quantities, or for better quality for your Microsoft Publisher print job than
you'd get with an inkjet or laser printer, you may want to take your publication to a commercial printer.
A print professional will use process color (CMYK) or spot color (black plus up to two special inks) to
reproduce your work on a printing press. In addition to longer press runs and higher quality, a printer
can offer a wide range of binding and trimming options.

Another excellent option is to take your Publisher job to a quick printer (also known as an “instant” or
“on-demand” printer). Quick printers can provide offset printing, as well as medium-resolution black and
white or process color output on devices such as the Xeroxe DocuColor~ and other digital output devices.
Cost, quality and turnaround are usually quite reasonable.

Publisher 2000 has many features, which, if used correctly, will make it much easier for commercial
printers, quick printers and service bureaus to prepare your job for the printing process. The following
tips will help you prepare your Publisher jobs for high-quality commercial or quick print output. If you
have questions about preparing your job, it's always a good idea to talk to your printer before you start
your project. If you need to find a printer who accepts files created in Microsoft Publisher, go to the
Publisher Service Provider Program referral database at www.microsoft.com/publisher/printers.
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Many of the tips listed here apply only to Publisher 2000, because Publisher 2000 includes features designed for
use by professional printers. Your printer or service bureau may have less confidence in publications converted
from older versions, such as Publisher 98, than publications desighed in Publisher 2000. One of the reasons for
this is that Publisher 2000 is device independent, which means that your currently selected desktop printer does
not necessarily control the appearance of your job. Because Publisher 98 and earlier versions of Publisher were
device dependent, the text in your older document may re-flow, and otherwise look different than you expected,
when opened by a printer or service bureau using Publisher 2000.

To upgrade to Publisher 2000 go to your local retailer or upgrade online at //shop.microsoft.com.

One of the advantages of using Microsoft Publisher is that you can easily create nice-looking publications by
choosing from the Publication wizards for newsletters, catalogs, brochures, business cards and more than 20
additional publication types. You can start with a wizard, such as the Newsletter Wizard, and then choose a Design
and a Color Scheme. You can use the wizard at any time to add additional objects to your publication, such as
more pages, change the Color Scheme, or even apply an entirely new design.

Should | Use Spot Color or Process (CMYK) Color Printing?
When you print your publication commercially, one of your first
decisions will be whether to use process color or spot color. If your
publication includes color photographs or artwork, consider using
process-color printing. If your publication includes a logo with one or Spot and Process Color?
two colors, or if you want to use color to emphasize line art or text,
then consider using spot-color printing. Once you make the decision,
you can design your publication for the type of color printing you've
chosen. For more information about deciding which type of printing
to use, see “Decide which commercial printing process you will use”
in Publisher Online Help.

Spot color uses custom inks or
pigments to display your publi-
cation’s colors. “Spot Blue”
ink, for example, is an actual
pigment, not a mix of other col-
ors. It is inexpensive, because

Publisher supports process- and spot-color printing and provides fewer inks are used.

all the tools your commercial printing service needs to prepare your Process color (CMYK) uses
color publication for printing. Before you design your publication and four standard inks to simulate
work with your commercial printing service, it's helpful to know the most of the hues in your design.
basics of process- and spot-color printing. “Blue,” in the process color

world, is really a combination
of Cyan and Magenta. It is
more expensive, but it gives
you more color choices.

How do Spot Color and Process Color Printing Differ?

Process- and spot-color printing differ in two important ways: The
range or number of colors each can reproduce, and the cost of
printing. In process-color printing, a full range of colors is reproduced
by combining four semitransparent inks. In spot-color printing, one or
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two colors (or tints of colors) are produced using semitransparent inks. Process-color printing is typically more
expensive than spot-color printing. Cost depends not only on the number of colors used, but also on the capacity
of the printing press and the complexity of the publication's design.

Why Should | Convert My Publication to Spot Color or Process Color — Can’t My Printer Convert it?

Check with your printer to see if you should do this conversion or if your printer or service bureau prefers to do this
themselves. Typically, if you know you're going to have your publication professional printed, it's a good idea to
convert your publication to either process (CMYK) or spot color early on to make sure that the right colors are
getting used. The Publisher default setting (RGB) may look great on your screen, but it will always look different
when printed. RGB (short for Red-Green-Blue) is ideal for on-screen viewing, such as on the Web, or for printing to
your desktop printer, but it will create unpredictable or unsatisfactory results when the file is separated to commer-
cial process colors. A vivid blue object, for example, would look fine on your screen, which can handle blues fairly
well. However, in commercial printing, a combination of cyan and magenta ink would be used, and the resulting
color would differ from the one on your screen, or your desktop printer.

Which Two Additional Colors from my Publisher Color Scheme will be used for Spot Color Printing?

If you’ve used a wizard to start your publication, choose your desired color scheme. If you're creating a spot color
job (black plus up to 2 colors), you should only pay attention to the first three colors in the Color Scheme (left to
right). The first color in the Publisher color scheme is always black; the next two colors would become either spot
color 1 or spot color 2 within your publication. Typically, the color that is used most frequently throughout your
publication will become spot color 1; the other color will become spot color 2.

What if | Need Four Colors?

I you would like your publication printed JRI e R

out in more than 2 spot colors (plus Format | Tools Table Arrange  Mai Merge Help
black), you'll need to print this as a

Speling 3
Process .(CMYK) job. In process printing, Lo >
the four inks CMYK (cyan, magenta, A B,
yellow, black) combine together to
create a much larger selection of colors; Design Checker ...
however, you may find it more difficult to Conmeck Texk Frames
match a specific color in the CMYK color

Snap ko Ruler Marks
space.

Snap ko Guides e+

After you select your colors, you can con- Snap to Obiects

vert your publication to either spot or
CMYK. To do this click the Tools menu, Options. ..
point to Commercial Printing Tools,
and then click Color Printing. Click
either Process colors (CMYK) or Spot
colors. For step-by-step procedures and
information about spot and process
color, see Publisher Online Help.

Carrercial Printing Tools  # Colar Printing. ..

Trapping ’
Graphics Manager. ..
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To convert your publication to Spot Color , use the following general steps:

Nz Optimizing Your Job For Commercial Printing

m Click the Tools menu, point to Commercial Printing Tools, and then click Color Printing (Figure 2).
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= In the Color Printing dialog (figure 2, above), click the Spot color(s) button.

m  Only one spot color will be activated by default—usually based on your “Accent 1” color. To get a second
color (as shown above) you must immediately follow the next step.

m Select the Change Spot Color button, and choose the desired spot colors. Note that your accent

colors will be among the choices. If you delay in selecting a second spot color, elements in other accent

colors may be converted to black, and will have to be re-colored manually.
Important: If you choose Spot Color mode, you can no longer choose a Publisher color scheme in the Design Wiz-
ard. Graphics will usually be converted to black. You may re-color any of these inserted graphics, changing them to
one of your spot colors, using the Recolor Picture command on the Format menu. The graphic changes to the
spot color. As an option, black elements may be left unchanged. Although photographs may be colorized, using the
Recolor Picture command, duotones are not supported in Publisher 2000. If Photoshop duotones are inserted,

they will not print correctly. Color Printing
To convert your publication to CMYK: —Print all colors as:
= In the Color Printing dialog, click Process " Composite RGE
Colors (CMYK) (Figure 3). % Praocess colors (CMYES:

Notice that you can still select from Publisher’s color " Spot colar(s)
schemes, but how the accent colors (as well as in-

. - (Ehange SEot Ealet.. . Spat color 10 F27777
serted graphics) are expressed as combinations of the Spot color 21 W
four process colors: Cyan, Magenta, Yellow and Black. ' ;
The on-screen appearance of your job will be different || =oiars sed:
from what it was in RGB. In some cases, colors may B YK (D, 0,0, 100) - Main (Black) =

) B crvE (o, 91, 100, 0) - Accent 1 (Red)

appear duller. However, you must select CMYK in 1 vk (1,0, 98, 0) - Accent 2 (Yellow)
order for your full-color job to separate and print L Accent < {(CMyK (0, 0, 0, 200
accurately at a commercial or quick printer.
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TIP 4: DISCUSS COLOR MATCHING

Color-matching systems, or guides, are large collections of colors that are designed to reproduce well in
commercially printed publications. Colors are usually identified by name or number, and solid (spot) colors are
often referenced by coated and uncoated color numbers. When you use a color-matching system, you can pick a
color and apply it to text, clip art, and other objects in your publication. If you choose a color from a color-matching
system for your company logo, for example, different printing companies that support that color-matching system

can print it and get consistent color reproduction.

Publisher supports the PANTONE MATCHING SYSTEM®. PANTONE is one of the most widely used color-matching
systems in commercial printing. Before you specify PANTONE Colors in your publication, ask your printing service
if they support the PANTONE MATCHING SYSTEM. If PANTONE is supported, use the following tips to decide which

color library to use:

m If you're designing a publication that uses black plus
one or two other colors, choose PANTONE Solid
Colors (Spot colors).

m If you're designing a publication that uses color
photos or art, choose PANTONE Process Colors.

m If you're designing a process-color publication and
want to match an object that uses a spot color, you
can convert a PANTONE Solid Color to the nearest
matching process color.

For detailed procedures, see “Choose a PANTONE spot

Choosze Spot Color

™ Black and white only

' Elack plus:

Spat colaor 1 I

¥  sSpotcolor 2

color for a commercially printed publication” or “Specific a process (CMYK) or PANTONE process color” in Publisher

Online Help.

m In the Color Printing
dialog, click Change
Spot Color and then
click More Colors (1st).

m  Be sure you are viewing
All Colors (2nd).

m  Change color model to
Pantone (3rd).

m  Select Pantone color
(Page 6, 4th).

m  Publisher will automati-
cally select Pantone
colors that are close to
the accent colors from
your color scheme.
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Your print service provider should have a
reference book or chart that will show you
what each Pantone color looks like when it is
printed. It's always a good idea to discuss the
use of Pantone with your printer before
starting.

TIP 5: REPLACE
PLACEHOLDER
IMAGES IN WIZARDS

The publication wizards in Publisher (for exam-
ple, the newsletter wizard) and photos in the
Clip Gallery include low-resolution images that
are suitable for desktop printing, but will not
reproduce well in a high-quality printing
environment.
In print, these
images may
appear rough

= PANTONE® Colors

PANTOME Solid | PANTONE Process |

- Caolor Tepe
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or “jaggy” — especially if they are enlarged within Publisher.

If you plan to use photographs in your publications, scan them in (see Tip 5) or
talk to your printer. You may also use print-ready images from a CD. If you are

using EPS graphic files 2 within your publication, you must link these images. For detailed procedures on using
EPS files, see “Insert Linked Images in a Commercially Printed Publication” in Publisher Online Help.

TIP 6: USE HIGH-RESOLUTION SCANS

Commercial and quick printers reproduce your photos as

a series of halftone dots (see the illustration at right). To
do this well, they must use scans with enough resolution
(pixels per inch) to make a high-quality printed halftone.
If the resolution is not high enough, the image will be

jaggy. Use this formula when scanning your own photos:

m  Ask your printer at what halftone line
screen (in lines per inch) the photos
will be printed.

m  Multiply that number by 2.

m If the photo will be enlarged in your
document, multiply by the enlargement
percentage. Use the resulting number
as your scan resolution (in pixels per
inch).

screen (ask) =

Times 2

Times the
magnification
(twice the
original size)

SCAN
RESOLUTION =

Example

Printer’s halftone

150 line
X2
300

X2

600 ppi

- [q
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Typical halftone resolutions are 85 (for newspapers), 100, 133, 150 and 200. A higher line screen will result in a
large file, especially if you are going to enlarge the photo in Publisher. However, this is necessary if you want your
photos to look good. Talk to your printer or service bureau for more help with scanned photographs.

Many of the color graphics found in the Microsoft Clip Gallery are in the Windows Metafile format (WMF). The
picture shown below is an example. These images can be customized: for example, a different color can be
assigned to the image using the Recolor Picture command on the Format menu. WMF
images can also be enlarged without loss of quality.

Publisher 2000 usually can create good color separations from these files;

however, some older imagesetters do not support WMF graphics. Be sure to ask

your printer or service provider if these will output correctly. If your service bureau

or printer do not support WMF images, you will need to resave these images in the
Encapsulated PostScript (.eps) format, or the Tagged Image File format (.tif). To
change WMF files, open them in the Windows versions of Adobe lllustrator or Macro-
media FreeHand, make changes, if necessary, and export in EPS or TIFF format. Your

print service provider may be able to do this for you. EPS images can be enlarged and still look good, but you
cannot recolor EPS images within Publisher. TIFF images will appear rough or “jaggy” if they are enlarged within
Publisher, but TIFF images can be re-colored to a single accent or spot color.

If you are using EPS graphic files within your publication, remember to link these images. If you do not link these
images, they will be converted to WMF format during the Pack and Go unpacking process. For detailed proce-
dures, see “Insert Linked Pictures in a Commercially Printed Publication” in Publisher Online Help.

Publisher 2000 includes the easy-to-use Pack and Go Wizard that will help you collect all the graphics, fonts and
files your printer or service provider needs. After you've saved your document, click the File menu, point to Pack
and Go, and then click Take to a Commercial Printing Service. The steps below outline the general procedure.

For more detail, see “Pack Your Pack and Go Wizard HE

Publication” in Publisher Online Help.
Choose the location for saving your files
1. Choose a drive

' — 2
Removable disks (Zip) and floppies Where would you like to pack your publication ko

can easily be delivered to your
printer or service bureau. If you want
to email your job, you can save the A

Pack and Go files to a directory on ‘o I D\Flver Project) Browse, . |

your hard drive.

2. Include fonts and graphics

Unless your printer tells you other-

wise, always embed fonts and —
include linked graphics (Figure 4). < Back |

Cancel Fimish
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Embedding TrueType fonts will
save you and your service
provider hours of time.

When graphics are inserted in
your publication, they can be
linked to the file. If you forget
to do this, don’t worry (The only
exception is EPS graphics. To
insert EPS files correctly, you
must select Link to File ,
instead of Insert, in the Insert
Picture dialog box). Pack and
Go lets you create external links
for all embedded graphics.

2. Pack the publication

Optimizing Your Job For Commercial Printing

Pack and Go Wizard

Include fonts and graphics

Pack and Go can include linked graphics and fonks used in yvour publication,

If wou're taking the files to a commercial printing service, the wizard can also create links For
graphics yvou've embedded,

[ Embed TrueType Fonts
[+ Include linked graphics
[ Create links For embedded graphics

< Back Cancel Einish

After you have completed the previous steps, click Finish to copy and compress the files for your printer or service
bureau. The Pack and Go wizard will create the following files:

unpack.exe — This is a small software program your printer or service bureau will use to open and
“decompress” your files. All he or she has to do is double-click the program icon, and all the required
files will be copied to a specified location on their computer.

readme.txt — This is a text file, explaining how to unpack your files.

packed01.puz (and possibly packed02.puz, packed03.puz, ctc.) — There will always be at least one
puz file. These contain compressed versions of your Publisher job, inserted graphics and TrueType fonts.

When your printer or service bureau unpacks your job, he or she will have an exact copy of your Publisher 2000 file
(with the letters “PNG” added to the file name), as well as all the inserted graphics and TrueType fonts required to
reproduce the publication. This will greatly reduce the amount of time needed to produce your publication.

4. Print laser proofs

After your publication is
successfully packed, you have
the option to print a composite
version and a color-separated
version to your own inkjet or
laser printer. This is always a
good idea! These printouts
represent the same version of
the document that you just
packed. Be sure to send the
print-outs to the printer, along
with your floppy or Zip disks.
By following these simple
guidelines, you will enable your
printer or service provider to
efficiently output your files.

Pack and Go Wizard EHE
Your publication is successfully packed

The wizard copied Unpack.exe and your packed File inko the directory wou chose, Run
IUnpack. exe when wou want to unpack vour publication,

If vou make changes ko your publication, use the Pack and Go Wizard again.

[+ Print a composite

[+ Print separations
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As discussed in TIP 7, the Publisher 2000 Pack and Go Wizard makes it easy for you to include the correct fonts
and graphics in any publication you plan to send or take to a commercial printer — the wizard will embed TrueType
fonts and link graphics so that the printer can reproduce them accurately. You'll need to keep in mind the
following, however, when you’re designing the publication:

= Use TrueType Fonts

Although you can use either TrueType or PostScript fonts in your publication, it’s may be best to use only
TrueType fonts for two reasons:

e Publisher embeds TrueType fonts that are used in a publication when the fonts are not already
installed with Windows, and have licenses that allow embedding. When you use the Pack and Go
wizard to prepare your file for an outside printer, TrueType fonts are automatically embedded in the
publication (all 200 TrueType fonts that came with Publisher 2000 have full license for embedding).
Publisher cannot embed PostScript or other non-TrueType fonts in your publication. Check with your
printer if you are using fonts other than TrueType.

e  When you use TrueType fonts, your printing service can use all of Publisher’s advanced features, such
as trapping, to prepare your final file for printing.

= Don’t Apply Special Formatting to plain text; use a different font
For example, if you are using Arial font for the body text of your publication, but you need some larger, bold-face

headings, use a font such as Arial Black or Helvetica Bold, for the headings. Doing so will ensure that your
headings look crisp and accurate. When you apply special formatting such as bold and italic to a the Arial font,
you've created a “synthetic font”. Synthetic fonts may not print correctly.

Avoid copying and pasting text from other programs or from the Web
All the TrueType fonts that are included with Publisher provide full rights for embedding the font within your

publication. If you copy and paste text into your Publisher publication, from another application or from the
Web, you may be pasting a font that’s not licensed for embedding. To avoid problems, be sure to change the
font that you just copied into Publisher to a font that you are using in your publication. For example, your
publication text is Arial. You copy a paragraph of Antique Olive text from a word processor file. Within Publisher,
select the text and change the font to Arial.

Use original graphics that you import or insert; don’t copy and paste
It's always tempting to simply copy a graphic that you like, for example, from the Web. It's very important,

however, that you use original graphics in any publication that you plan to take to a commercial printing service;
otherwise, the Pack and Go Wizard may not be able to link the graphic properly, which means that the printer
won'’t be able to reproduce the graphic accurately. In addition, graphics copied from the Web are typically low-
resolution images which will not reproduce well in commercial printing.

Refer to Publisher Online Help or the Publisher Companion Guide
For more information on preparing files for printing or the commercial printing process, refer to Chapter 3 and
Chapter 6 in the Microsoft Publisher 2000 Companion guide, see Publisher Online Help.
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